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President's Letter 
 from Carl Nordeen 

 
    

  

Not Available 

THIS MONTHôS MEETINGS 
 

August 1 at 1 p.m. 

At FFG Community Church  

Photography Club 

 

August 16 at 10 a.m. 

At 127 S. Senior Center 

Investment SIG  

 

August 18 at 6 p.m. 

At 127 S. Senior Center 

General Meeting 

 

Please note that the time of our general meetings has 

changed to the summer schedule. Meetings begin at 6 

p.m.  

 

Ask the Experts Q&A 

Short Business Meeting & Program 

 

August Program 
 

The August program on da Vinci Robotic Surgery 

will be presented by Tim Doulin, BSN, RN, the Clini-

cal Sales Representative for Intuitive Surgical for the 

Plateau Region. The program will include the history 

of robotic technology and Intuitive Surgical; local 

and national adoption of Intuitive robotic technology; 

an overview of  clinical applications/key surgical pro-

cedures; and a ñshow and tellò involving selected da 

Vinci System components (There will be a live dem-

onstration of the entire da Vinci Surgical System on 

Aug 27 in Fairfield Glade.) 
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ñFREEò Table 

We have set up a table at our member meetings to share our 

ñextraò goodies with other club members. 

If you have something to give away, bring it in and put it on the 

FREE table.  Itôs first come, first served.  If you see something you 

want, help yourself. 

 

Membership Dues and Expiration Dates 

 

Membership dues are $25 a year for a family, $20 a year for 

an individual, and $10 a year for a student 21 years of age or 

under. Your membership is valid for 12 months from the 

month you join (or renew your membership).  Please pay 

your dues to the treasurer before the last day of your anniver-

sary month. Anyone who is 30 days or more in arrears with 

membership dues cannot participate in the door prize draw-

ings. 

 

Corporate memberships are $25 a year for the first two mem-

berships and $10 a year for each additional membership from 

the same company. 

 

Our Club cannot exist without you, the members.  Remem-

ber, you and  your membership dues are important to keep 

the club functioning! 

 

BOARD OF DIRECTORS DISCLAIMER 
All members of the Plateau PC Users Group are willing to help 

one another in the area of advice and tutorial instruction over the 

phone.  If you should require more involved services or instruc-

tion, we have a few members who are very knowledgeable in sev-

eral areas.  As a responsible consumer, it is up to you to discuss, 

before retaining a member, any and ALL charges for repair ser-

vices and time consuming tutorial activities. 

 

It is not the desire of this Board of Directors to set fees for indi-

viduals for services rendered, nor the responsibility to intervene 

between members who enter into a contract among themselves 
 

The GAZETTE is published using the following:  Microsoft 

Word, Microsoft Publisher, and Microsoft Windows 98,  The 

GAZETTE is the monthly newsletter of the Plateau PC Users 

Group.  Material in the GAZETTE may be freely used in other 

user group newsletters if credit is given the author and the 

PPCUG GAZETTE.  PPCUG members may place free classified 

advertising (up to 50 words) in the GAZETTE (run time maxi-

mum of three months).   

Commercial ads (local advertisers) may be placed at 50 cents per 

line. Graphic ads (camera ready) are as follows:  $25 per 1/4 

page, $40 per 1/2 page, $75 per full page. 
 

DISCLAIMER:  No warranty, express or implied, is made by 

the PPCUG, the Gazette editorial staff or its contributing 

editors.  This extends to all losses incidental or consequential 

from the use or non-use of any information in any issue of the 

GAZETTE . 

 

 

 

 

     

President Carl Nordeen  (931) 456-5597 

Vice-President  Kay Cargill (931) 456-7613 

Treasurer Alan Baker  (931) 788-2201 

Secretary Patricia A. Anulewicz  

Librarian/Compliance  Gordon Botting  (931) 456-2184            

Past President Carl Nordeen  (931) 456-5597 

Programs Open  

Membership Janet Hammond  (931) 484-6023  

Publicity Open  

Product Rev. Chair Peter Kaufmann           (931) 456-9353  

Editor Don Lewis (931) 456-5352 

APCUG Rep  Peter Kaufmann           (931) 456-9353  

Equipment Custodian Bob Willis (931) 456-6511 

Webmaster Don Lewis (931) 456-5352 

Directors at Large 

Jim Mansfield  Harriette Weidner Joan Carroll 

Bob Willis Don Lewis  Janet Hammond  

Dick Riesz  Pearl Harter  Roger Holyer Black  

   

 SIG Leaders   

Pleasant Hill Dick Riesz (931) 277-5642 

Investment Club Bob Mohar  (931) 707-0434  

Photography SIG Jim Mansfield (931) 484-6920 
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News of the Special Interest Groups 
 

The PPCUG sponsors several Special Interest Groups 

(SIGs) tailored to meet the varied needs of our many 

members.  Each SIG is a small group whose leader 

prepares material for presentation and encourages 

open discussion and questions.  We urge you to attend 

the SIGs and hope you will find one or more of inter-

est to you.  Ideas for additional groups are welcome, 

as are volunteers to form and lead new SIGs. 

 

Investment Club 

 
Meets the third Saturday of each month at 10 a.m. at 

the 127 S. Senior Center. The leader is Bob Mohar .  

Anyone interested should contact Bob  at 707-0434ò. 

 

Pleasant Hill Group 

 
The Pleasant Hill group meetings will be announced 

by the SIG Leader, Dick Riesz. Meetings are held in 

the Pleasant Hill Community House on Main Street 

across from the Pleasant Hill Post Office.  All mem-

bers are welcome and visitors from the Pleasant Hill 

area are especially encouraged to come.  
 

Photography Club 

 
The Photography Club, a PPCUG SIG, meets the first 

Friday of each month at the Fairfield Glade Commu-

nity Church at 1:00PM.  Topics vary each month but 

we show and discuss member's photos each 

month.  One or two "People's Choice" photos are 

submitted to the Glade Vista each month for publica-

tion. The SIG leader is Jim Mansfield. 

Up Coming Meeting 
 

September 2008 !!! 

 

The next General Meeting of the 

PLATEAU PC USERS GROUP 

Will be September 15 at 6:00 P. M. at 

127 S.  SENIOR CENTER 

 

Program to be determined.  

 

New Members 

 

No new members this month 

 

Cool Sites 

 
http://snopes.com/ 

 

Do you receive emails that have been forwarded all 

over the world and say bad things about your favor-

ite politician or good things about the politicians you 

hate? Do you get emails that tell about deadly viruses 

that will render your computer useless and that there 

is no way to keep from getting it or cure them? 

Maybe they tell about ATM, employment, sales, 

identity theft scams and many other scams. Are they 

true? The Urban Legend site, Snopes researches 

many such emails and tales to come up with the 

source and validity of these rumors. Search on the 

title of the email or key words.  Try searching on the 

names of both of the candidates for president. It 

makes interesting reading. 

 

Please send your cool site suggestions to me at 

 webmaster@ppcug.com 

 

PPCUG ISP 
 

We wish to thank the following for providing ISP 

connections:  

 

Multipro for dialup at Pleasant Hill  

Charter for cable broadband at the 127 Senior 

Center 

Frontier for DSL at Fairfield Glade  
 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The Learn-

ing Center class schedule and Gazette are all 

 available on our web site. 
 

Send your comments and suggestions to the  

Webmaster, Don Lewis 

Webmaster@ppcuginc.com  (931) 456-5352 

http://snopes.com/
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Minutes of the Membership Meeting 
July 21, 2008 

 

Question & Answer:  Sessions began at 6:00 pm at the 127 South Senior Center.  The Vista group met in the dining 

room with Carl Nordeen leading.  The large group met in the meeting hall with Alan Baker fielding questions on 

how to use the Windows help system, using órestoreô as a search word in Windows XP Forward, audio copying, 

video telephone, Skype 4.0, and the AVG free anti virus. 

 

Call to Order:   At 7:00 pm by Kay Cargill, Director At Large. 

 

Program:  Alan Baker presented a comprehensive program on óWhat Is An iPod?ô.  It is a portable miniature media 

player combined control unit.  No instructions come with it, so you have to learn how to use the symbols on the 

wheel.  Comes in a wide price range, plays music, displays photos and plays movies.  Has data storage, games, FM 

tuner and a voice recorder.  Stores a huge amount of songs up to 40,000.  A number of accessories are available for 

purchase.  Alan demonstrated how to download music from the PC to the MP3 player.  

 

Suggestions for Future Classes:  Members expressed an interest in email photos, how to edit digital photos, and 

dealing with digital files over the Internet.  Kay Cargill suggested that all XP users combine with the Vista users in 

the meeting hall rather than be separated into two rooms.  

 

Forum Website Postings:  Alan will post how to install Frontier systems, Outlook email multiple page printing 

problems, email large distribution blocking and G(google) mail. 

 

Announcements:  Alan Baker will hold a second class on Excel Wednesday, July 23rd at 5:30 pm at the 127 South 

Senior Center.  There will be a minimal fee.  The only month there will not be a meeting is December.  

 

Membership:  Stands at 192 members with $6,200 in the bank.  Alan stated the only plans to date for the $6,200 in 

the bank is for scholarships. 

 

Old Business:  None discussed. 

 

Door Prizes:  A 1-gigabyte flash drive was awarded to Carol Haverdink and one to Jim Buxton 

 

Adjournment:   8:00 pm 

 

Submitted by Harriette Weidner for Patricia A. Anulewicz, secretary 
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Adobe Photoshop Elements 6 
By Jim Mansfield 

July, 2008 

 

Adobeôs Photoshop Elements 6 is the most recent version of the non-professional photo editing software that Adobe 

has been publishing for several years.  For those who donôt need or canôt afford the $600 plus price tag for Photo-

shop CS3, this program is the industry standard.  Most digital photography magazines and books refer to techniques 

in Photoshop programs.  Photoshop Elements 6 allows everyone, from a beginner to a semi-serious photographer, to 

be able to make minor or major modifications to their photographs. 
 

The software is widely available in retail stores and online.  There will probably be a newer version coming out 

soon, this one was issued in the fall of 2007.  Online prices are about $60 and the package includes a DVD, an 18 

page ñGetting Started Guideò and an ñEditing Keyboard Shortcutò card. 

 

System requirements include: An Intel Pentium 4, Pentium M, or Intel Centrino 1.3 GHz processor; Windows XP 

with Service Pack 2 or Windows Vista (a Macintosh version is also available); 256MB of RAM (512MB recom-

mended); 1.5GB of available hard-disk space; Color monitor with 16-bit color video card; a 1024x768 monitor reso-

lution at 96dpi or less; Microsoft Direct X9 compatible display driver; and a CD-ROM drive. 

 

Installation was pretty straightforward, taking about 15 minutes to complete the install, restart the computer and then 

register online.  A ñWelcomeò screen asks if you want to ñOrganize, Edit, Create, or Shareò your photos.  You can 

choose from this menu each time you start it up or ask the program to always start in one of those modes.  I did get 

an annoying pop-up asking if I wanted to win a laptop if I made a movie. 

 

As soon as you start to use the program, you run into the biggest problem with this software.  The included ñGetting 

Started Guideò(18 pages) is very brief and almost useless in using the program.  There is no tutorial, no written man-

ual nor is there a manual on the DVD. The only source of ñHelpò is online.  Unless you have a high-speed connec-

tion or have purchased ñHow-toò book, you will be lost. You can download and print the over 400 page manual if 

you have enough ink, paper and time.   If you have used Photoshop before or some other photo editing software, you 

can begin to explore and follow some limited guidelines in the software.  Otherwise, you must access the Internet 

for almost every bit of information, including a Glossary.  Unless you have a high-speed connection, the book (e.g. 

Missing Manual for Photoshop 6 about $26.00, Photoshop 6 for Dummies about $17.00) or a high tolerance for frus-

tration, do not proceed until you get one or more of them. 

 

As you start to use the program, each function used for the first time will have to go through an annoying ñloadingò 

or ñpreparing functionò delay.  In the ñOrganizerò mode you can import photos from your files on cameras, scanner, 

hard drive, or even mobile phone.  Once the photos are there, you can have the program automatically scan for, and 

correct red-eye.  Photos can be also arranged and categorized by date, keyword tags, star ratings, file name, media 

type, etc.  You can also create ñAlbumsò to keep photos together while working on a project.  A handy and timesav-

ing function in Organizer is to click on one or more photos and have the same action taken on all of them.  You can 

have red-eye removal, ñAuto smart fixò, Auto Color, Auto Contrast, and Auto Sharpen done on several photos at 

once.  This may be enough correction for most of your shots.  It would be useful if there was a ñbeforeò and ñafterò 

comparison on the screen in Organizer.  You can always ñundoò but that reverses the changes to all the photos you 
(Continued on page 6) 

Product Review Page 
This page will be devoted monthly to reviews of computer products chosen by our Product Review Coordinator 

Pete Kaufmann. The Editors encourage PPCUG Members to ñget a productò from Pete, evaluate it and write a re-

view. The product then becomes yours! 
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selected. 

 

In the ñEditò mode, you are in the most useful function of the program.  You are able to use ñGuidedò, ñQuickò, and 

ñFullò edit modes.  The easiest to use is the Guided mode.  There you are led through Basic (crop, rotate, and 

sharpen), Lighting and Exposure (Enhanced color, Remove color cast, and Skin tones), and Guided Activities (touch 

up and photomerge) edit modes.  In each activity, you view a before and after photo and a slider to move until you 

get the effect you wish. Each correction also has an ñautoò button if you donôt want to make the slider adjustments 

yourself. 

 

In the ñQuickò mode you go directly to the Smart Fix, Lighting, Color and Sharpness controls.  Again you can use 

the auto fix button or make the changes yourself with the slider. 

 

In the ñFullò edit mode you get into Layers, Filters and dozens of Effects that you can apply to the photo for more 

detailed correction and artistic results.  You can experiment with these functions or refer to a manual to get the result 

you wish. 

 

The other two main functions of the program are ñCreateò and ñShareò.  In the Create mode you can produce Photo 

Books, Calendars (though you are sent to an online link to order it from Kodak), Collages, Online Galleries, and 

Slide shows.  In Share, you can send photos to an online gallery, an email attachment, Photo mail, order online 

prints or create a CD/DVD. The process to send an email with a photo was annoying.   You had to use Adobe email 

and get an email sent to your account.  You then had to enter into the verification screen a 32-character code sent to 

your email.  Finally, you could send the email to someone. 

In comparison to other photo editing programs, Photoshop Elements 6 probably has more capabilities for the ad-

vanced user.  Paint Shop Pro X however, has an excellent Learning Center and useful Help without using the inter-

net.  Picasa and Paint Shop Pro can do many photo editing functions as well and with a shorter learning curve. How-

ever, in the long run, Photoshop 6, after spending additional money to buy a manual, will be worth the investment. 

 

Wireless Router Setup 

 
By Bob Elgines, Editor, Colorado River Computer Club, Arizona 

www.crccaz.com/ 

elginesz@rraz.net 

 

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

 

How to change the setup or configuration of your Wireless Router and PC. First we need to get to your router after 

the original setup by bringing up Internet Explorer on your direct wired computer (Master) and typing in one of the 

code addresses below: 

 

 TYPE CODE USER PASSWORD  CHNL  

    Belkin:    192.168.2.1 (No Name) (Leave Blank)    6 

   D-Link: 192.168.0.1   admin (Leave Blank)    6 

   Linksys:  192.168.1.1 (Leave Blank)     admin   11 

  Netgear:  192.168.0.1   admin    password   10  

 

A login screen will appear; if you used your own login name and password then use them. If you lost them and you 

wish to reconfigure your router, you will have to push the reset button for at least 30 seconds. This sets the router 

(Continued from page 5) 

(Continued on page 7) 
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back to its defaults and you can use the default values above. 

 

During your setup you may have seen ñNumber of DHCP users allowedò, reduce this to the number of total com-

puters in your network or that number plus one. 

 

SSID is your wireless network name, for example, Linksys will broadcast ñlinksysò. First, we want to rename your 

SSID and then hide it later. After changing the name, we need to reconnect with each wireless computer. To recon-

nect, right click the icon in the System Tray (or task bar-right).  

 

Windows XP SP2 - Choose Available Wireless Networks / Change 

Advanced Settings. Click the Wireless Networks tab, click Add button 

in the Preferred Network section.  

Type in the Network name you have chosen, then click OK twice.  

 

Windows VISTA  - Select Network and Sharing Center, then left click 

on View Status (located middle-right). Click on Wireless Properties 

button. Put check mark on ñconnect even if the Network is not broad-

castingò.  

 

(Or go to START / CONNECT TO / click on your SSID and click the CONNECT button below. Then you can right 

click on your SSID and select Properties. This will get you to your Wireless Properties window where you can put 

the ñcheck markò and enter your Security code.)  

 

Complete this on all of your wireless computers and remember how you got there! 

 

 

 

 

Second, now we can choose to stop your Router from broadcasting 

your SSID by selecting disable to ñSSID Broadcastingò in your router 

setup. All your computers should be reading the wireless connection. 

 

Next step is to select a Security type, let us try WEP first. This may 

be slightly different due to different manufactures. Usually you will find it 

under Security or Wireless tabs of your router setup. Select 64 or 128 bit 

encryption, then type in a word or phase and let the router do the coding by 

clicking on Generate. Select #1 and write down this code for your wireless 

computers. Go to the Wireless Properties window and click on the SECU-

RITY tab. Then set the ENCRYPTION type to WEP and enter the security 

code you wrote down, click OK and Close. Key Index should remain on 

one. 

 

Look at the Security Type by clicking the down arrow on the right. Note these are the other types of security al-

lowed: WPA2-Personal, WPA-Personal, WPA2-Enterprise, and WPA-Enterprise. Most newer routers and computer 

can operate with this type of security and is considered better than WEP. 

 

We completed a simple setup to supply a secured wireless connection. You can go further and use one of the WPAs 

if all of your computers will accept this. Just disable WEP and enable WPA and roughly go through the same proc-

(Continued from page 6) 

(Continued on page 8) 
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ess. You could also assign your MAC addresses, but how far do we have to go?  

 

Following are definitions for MAC, DMZ, WPA, DHCP, and the router FIREWALL: 

 

DHCP ï Dynamic Host Configuration Protocol as a server assigns IP addresses to all computers on the network (in 

this case the router is the DHCP server). 

DMZ  ï Dedicated Multi Zone exposes a computer directly to the internet with a IP address. Some games require 

this direct access. You could give a false address not used by your computers to send intruders to an address that 

goes no where! 

FIREWALL  ï The routerôs firewall gives protection on data coming in, but not going out. If you wish full bi-

directional protection you will have to use software and replace your windows firewall which is incoming only. 

MAC  ï Media Access Control is a number related to the network adapter in a small network. LAN-MAC address is 

for your internal network and WAN-MAC address is used for router to modem connection. You can find your Client 

table (IP and MAC addresses) in your routerôs configuration utility.  

WEP ï Wifi Encryption Protection is the old security standard that can be used with either 64 or 128 bit encryption. 

WPA ï Wifi Protected Access is the latest network security standard, but if your equipment is over two years old 

you may want to checkout www.wi-fi.org web site for information. For full instructions on activating WPA see PC 

Magazineôs step by step article at http://www.pcmag.com/article2/0,1759,1819544,00.asp  

 

This article has been provided to APCUG by the author solely for publication by APCUG member groups. All other 

uses require the permission of the author (see e-mail address above). 

 

Firefox 3 ï Hot New Browser 
 

By Ira Wilsker, APCUG Director; Columnist, The Examiner, Beaumont, TX; Radio and TV Show Host 

Iwilsker(at)apcug.net 

 

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

 

WEBSITES: 

http://www.getfirefox.com ï Free Download 

http://www.mozilla.com/en-US/firefox/features/ - Features 

https://addons.mozilla.org/firefox/ - Add ons 

 

After a lengthy wait, Mozilla has released the latest and greatest release of the very popular web browser, Firefox 3. 

This new release, available for free download from www.getfirefox.com, has many new features, making it a very 

strong competitor to Microsoftôs ubiquitous browser, Internet Explorer. 

 

Firefox evolved from an earlier browser, Mozilla, which in turn grew out of the Netscape browser as AOL an-

nounced the cessation of Netscape development.  Since its first release several years ago, Firefox in its current and 

previous versions has developed a wide following, with hundreds of millions of copies downloaded. The newly re-

leased version 3 has tentatively set a Guinness world record with over 8 million copies downloaded in its first 24 

hours of public release, despite overloaded servers that discouraged countless people from downloading it the first 

day of issue. According to published reports, the number of copies of Firefox 3 downloaded surpassed 14 million 

downloads in the first 72 hours. Obviously, many people are using it. 

 

Rhetorically, so why are so many using Firefox 3 rather than Internet Explorer (IE), which is installed by default on 

(Continued from page 7) 

(Continued on page 9) 

http://www.wi-fi.org/
http://www.pcmag.com/article2/0,1759,1819544,00.asp
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all contemporary Windows computers?  There are several other fine browsers in circulation, such as the newly re-

leased update to Opera, and Appleôs Safari (for both Windows and Mac), but for Windows computers, Firefox is 

firmly in second place, right behind Internet Explorer. If Internet Explorer was not preinstalled on Windows com-

puters and integrated into the operating system, there is a good chance that Firefox 3 could surpass IE in a fair com-

petitive market. Firefox 3 is faster rendering web pages than IE, has superior tabbed browsing, is written in tighter 

code taking fewer system resources, and has many advantages over IE. There is no reason why PC users should not 

download Firefox 3 for Windows (7.8mb download), and install it, as it runs happily on computers that already have 

IE installed. On a fresh installation of Firefox on a Windows computer, Firefox will nondestructively import the fa-

vorites (bookmarks), cookies, and other information from IE, without making any changes or impeding IE in any 

way. If Firefox 3 is installed on a computer that has an older version of Firefox installed, it will automatically install 

it as an upgrade, including all bookmarks, passwords, cookies, and other information. Once installed, many users, 

such as me, prefer to use Firefox instead of IE. In my case I would say that I use Firefox for 98% of my browsing 

tasks; it would be 100%, but I have IE setup to access another internet account that I have, but rarely use. 

 

According to the Firefox 3 website at www.mozilla.com/en-US/firefox, over 15,000 improvements were made to 

version 3 over version 2. The newly released version 3 is claimed to be faster, safer, and smarter than the previous 

version, and also IE! One of the new features, which I have personally verified, is the fact that web pages do indeed 

load faster than on IE and previous versions of Firefox. Firefox 3 also consumes less system memory and system 

resources, leading to improved computer performance when Firefox is loaded and running, compared to the previ-

ous version, or even IE. Firefox 3 is also more secure than previous browsers, and incorporates the latest technolo-

gies to help prevent phishing (identity theft), and other website forgeries. A neat new feature in Firefox 3 is ñInstant 

Website IDò, where clicking on the tiny website icon (ñsite faviconò) at the left of the URL in the menu bar will dis-

play site information and identification, which will likely indicate if the site is as intended, or a web forgery.  Fire-

fox 3 has also been engineered to work smoothly and compliment Vistaôs parental controls, as well as most antivirus 

and other security programs. 

 

Another interesting feature unique to Firefox 3 is the ñSmart Location Barò that shows detailed information on web-

sites recently visited, and is accessed by clicking on the right side of the menu bar. This Smart Location Bar is intel-

ligent, in that it adapts to persona preferences to locate better website matches. Typing a ñtagò or keyword in the 

menu bar opens a detailed list of previously visited websites containing that keyword, making it very fast and easy 

to locate websites that have previously been visited. Another very useful feature is the integrated spell checker, 

which underlines any misspelled words typed in a browser window; right clicking on the word opens a list of sug-

gested spellings, which a mouse click will instantly replace the incorrect word with the correctly spelled word. 

 

Malware of various types, including worms, Trojans, viruses, and spyware is a growing menace to internet users. 

Firefox 3 integrates a sophisticated anti-malware feature that provides some protection if the user either intentionally 

or erroneously accesses a website that contains attack code. If such a dangerous website is accessed, a full screen 

(browser window) display will appear as a warning. Firefox, working with other organizations (including Google) 

maintains a continuously updated list of so called ñattack sitesò, so there is nothing for the user to update or main-

tain. In the event the user does happen to fall into a suspect site, such as a very freshly created phishing (identity 

theft) website, the forgery can be quickly reported by simply clicking on HELP ï REPORT WEB FORGERY; this 

will connect to a Google service that collects such information on a real-time basis, verifies the forgery, and auto-

matically adds it to the malware list, as well as forwards the information to groups like Phish Tank 

(www.phishtank.com) for further action. 

 

Many of us use multiple passwords and user names on countless websites.  Firefox 3 has an excellent integrated and 

secure password manager. When a password is first entered, Firefox 3 asks if you want it to remember that password 

and logon information, without any annoying pop-ups. Speaking of pop-ups, Firefox 3 incorporates a sophisticated 

(Continued from page 8) 

(Continued on page 10) 
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and easily configurable pop-up blocker which can stop pop-ups and pop-unders, speeding and making more enjoy-

able the surfing experience. In some cases, pop-ups are not irritating advertisements, but instead contain important 

information; these can be easily allowed when desired. 

 

Many of us choose to tweak the appearance and features of our browsers, and Firefox 3 happily obliges. Firefox has 

many themes and ñpersonasò that can be selectively implemented to change the appearance of the browser to meet 

our individual tastes. For those of us who want additional features, Firefox offers over 5,000 free ñadd-

onsò (addons.mozilla.org/firefox), which are easy to install devices to customize the browser to work as desired. I 

have installed about a dozen add-ons, including some security add-ons (PhishTank, McAfee SiteAdvisor, and oth-

ers), as well as an enhanced download manager (the one integrated in Firefox 3 is very adequate for most users). I 

also have selected to use differently colored tabs on the top of the browser window, an add-on that can make a tab 

an IE window (for the rare cases when a website is intended for IE only), a PDF manager, and several other add-ons. 

 

Firefox 3 is an outstanding and free product. It is a very worthwhile competitor to Internet Explorer, and users 

should try it to see if they like it. I like it, and use it almost exclusively on my desktop and notebook computers. That 

is the best recommendation I can give it. 

 

This article has been provided to APCUG by the author solely for publication by APCUG member groups. All other 

uses require the permission of the author (see e-mail address above). 

 

From My Vista 
 

by Rob Limbaugh, President, Danbury Area Computer Society, CT 

www.dacs.org 

relimbaugh(at)dacs.org 

 

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

 

Just about every year I make some sort of ómajorô effort to move forward with technology in some way on my pri-

mary home workstation. I periodically wipe out the machine and start a fresh OS install from scratch. I reasoned that 

as laborious a reinstall is, I may as well bite the bullet and this time make the move to Vista. What made the timing 

right was that Microsoft gave Windows Vista Ultimate 32-bit w/SP2 for those who attended the APCUG 2008 LDC. 

Hereôs my experience. 

 

Check Compatibility 

When loading an OS it is important to make note of your hardware and key software. Vista Update Advisor will 

highlight any hardware or software compatibility issues of which to be aware. In my case, the only issues to address 

were applications that would be replaced with new Vista versionsðno big deal. In terms of hardware, my machine 

checked out OK. Last I had heard, my ATI All-In-Wonder 2006 video card was not yet supported in Vista, so I dou-

ble checked the AMD (they now own ATI) website and confirmed there are now Vista drivers and software. Itôs a 

Go! 

 

Backup Data 

Next, I made backups of all my important data. This time around I used an external USB hard drive and just dragged 

and dropped the data to a óbackupô folder. I wanted to start fresh and clean, so I didnôt bother making a backup of 

my Windows or Office user settings. There arenôt any new BIOS updates for my motherboard, so I was all set to go. 

 

(Continued from page 9) 

(Continued on page 11) 
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Time for Install 

I started the install process around 8 p.m., electing to wipe all partitions on the hard drive. My first boot to the desk-

top post install was shortly after 10 p.m. So far, so good. And, considering this is a P4 2.4GHz machine, I was rather 

impressed. Vistaôs graphics worked from the get-go because the ATI All-In-Wonder 2006 uses an ATI Radeon 9600 

compatible chipset for which Vista loaded drivers. Sound worked. Networking worked. I expected SOMETHING to 

be wrong, due to all the horror stories I had heard! My machine even received a 3.2 on the ñVista Experience In-

dexò. That means I can use Aero! Now weôre cooking! 

 

Post Install Issues 

A notice appeared that Windows detected hardware and needed to install drivers. My systemôs motherboard has an 

integrated Realtek ACô97 sound card. Unfortunately there isnôt a Vista driver for the MIDI interface. If I want to 

hook up MIDI devices in the future, I will probably need to disable the built-in sound card and install a properly 

supported one to gain MIDI interface functionality. 

 

Watching TV is one of the things for which I built this machine, and I expected to use Vista Media Center. This is 

where my second issue came up. While AMD (they bought ATI) has released updated Vista drivers and software for 

the ATI AIW 2006 video card, they didnôt actually ófixô the issue with how the ATI Hydravision software accesses 

the TV Tuner. I searched around for a solution and came across a Home Theater application called ñBeyond TVò by 

SnapStream. So far that seems to solve my issue. Beyond TV has a ton of cool features (worth looking at even if you 

arenôt going to Vista). 

 

Reality Check 

In my consumer opinion, lack of proper drivers for an OS is the fault of the hardware integrator and not the OS 

maker. AMD is blaming Microsoftôs changes in DirectX 10 D3D (which happen to address performance and secu-

rity) as why the ATI TV Tuner software doesnôt work. Well, AMD, how come SnapStream could figure it out? 

AOpen has not released any new drivers for their implementation of the ACô97 chip on my motherboard. I can live 

with AOpenôs choice because most people donôt use the MIDI interface feature of sound cards. AMD has no excuse 

for not supporting an expensive video card that is bought for the very feature they arenôt supporting. My buying hab-

its will be adjusted accordingly in the future. 

 

Supporting Apps 

Along with Beyond TV, I installed what I consider óBase Supporting Appsô. These included Avast! Antivirus, Note-

pad++, Pidgin, Adobe Reader, Adobe Flash Player, Adobe Shockwave Player, TrueCrypt, PrimoPDF, and WinSCP. 

Office Ultimate 2007 is going to round out the Office Suite. Everything installed smoothly. No issues, arguments, or 

contentions between apps. 

 

Where I Stand 

My machine has paid its dues many times over and the driver issues didnôt affect my ability to use what I needed, so 

I was OK with that. Others with more particular needs should be aware that integrated soundcards, atypical hard-

ware, old devices, and fancy graphics capture cards may require special attention. Replacements may need to be 

considered. Iôm not suggesting everyone run out and install Vista. This is now the fourth time Iôve installed Vista on 

a machineðfirst time on one I plan to use regularly. All 

said and done, the experience has been pleasant and not anything like the horror stories Iôve heard. At the time of 

this writing itôs been about two weeks and all continues to work well. This article was typed on that system using 

Word 2007 and sent to the editors with Outlook 2007. 

 

From my vista, Vista works just fine. 

 

(Continued from page 10) 

(Continued on page 12) 
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Vista Upgrade Advisor: 

http://www.microsoft.com/windows/p r o d u c t s / w i n d o w s v i s t a /buyorupgrade/upgradeadvisor.mspx 

Compare Vista Editions: 

http://www.microsoft.com/windows/products/windowsvista/editions/choose.mspx 

SnapStream Beyond TV: 

http://www.snapstream.com/products/beyondtv/ 

 

This article has been provided to APCUG by the author solely for publication by APCUG member groups. All other 

uses require the permission of the author (see e-mail address above). 

 

E-Mailing Photographs 
 

By Richard Kennon, Editor, Amador Computer Users Group, CA 

www.acug.net 

Drtrdguy(at)volcano.net 

 

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

 

First, we must understand that photograph (image) size in the camera and in the computer is measured in pixels. 

These are the basic dots of color that make the picture. Do not pay any attention to anything that says ñinchesò or 

ñpixels per inch.ò These terms are meaningless when we are considering a picture either in the camera or in the 

computer. They may come into play later if we want to print the photo on paper. But, that is another subject for an-

other time. For now, we think only of pixels. Most cameras record too many pixels to e-mail. For instance a 6 

megapixel camera will make a picture about 3000 pixels wide by 2000 pixels tall and the file size may be several 

megabytes. Our screens are usually only about 1000 pixels wide (some are larger and some smaller). So, if we e-

mail the native picture, it will be wider than the screen for the recipient and the file will be so large, it may take 

ñforeverò to download to the recipientôs computer. It is possible the service provider will not even accept it. 

 

There are two things we must do to make a photo e-mailable. The first is to resize or resample the picture. We want 

to change the picture width from 3000 pixels to 800 pixels, for instance. This process is called resizing or resam-

pling. We have to pick the best 800 pixels out of the 3000 to represent our photo. Well, no, that is not exactly correct 

but it simplifies things to think of it that way. We donôt have to worry about it because a lot of very smart program-

mers have developed ways (algorithms) to help us. Just remember, you want to resize or resample to get the photo 

down to a size convenient for e-mailing. I usually use 800 pixels or 900 pixels width for pictures I attach to e-mails. 

 

The second thing to do to make a photo e-mailable is to save it in JPEG format (.jpg). That is a format that reduces 

file size a lot and picture quality a little so the picture can be downloaded more quickly and still be nice to look at. 

Some software programs give you choices of compression amount with numbers ranging from 1 to 10. One will re-

sult in a very small file but the picture quality will not be good at all. A 10 will give the very best quality but with a 

very large file size. A reasonable compromise is to use 5 or 6. I usually use 6. 

 

How do you do this? First, I will describe how to do it with a free Microsoft program. Then I will try to look at some 

other programs. 

 

Microsoft Power Toys for XP has a Resize Pictures toy that is slick and easy but feedback says it only works on XP. 

It can be downloaded at http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx. Right 

click on an image name or thumbnail in Explorer or My Computer and choose Resize Pictures. You are limited to 

four specific sizes but they are good choices. They donôt tell us what compression they are using but the results look 

(Continued from page 11) 

(Continued on page 13) 

http://www.snapstream.com/products/beyondtv/
http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
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OK. Unless you tell them under Advanced to replace the 

image in the file, it will make a copy. Thatôs good. They 

will add the word, ñLargeò, ñMediumò or ñSmallò to the 

end of the name you have chosen. 

 

If you are happy with this solution, then read no further. 

But, if you want to use a picture editing program, maybe 

this will help. 

 

In Photoshop Elements 5, click on Image>Resize>Image 

Size and this window will pop up. Note that there is some 

garbage at the bottom about ñinchesò but we will ignore 

that. First we will click the Resample Image box. That 

puts the Pixel Dimensions in play and that is what we want. 

I selected the Width box and changed the width to 800 pix-

els. Since the Constrain Proportions box is selected, that is all I have to do.  

 

Note, down at the bottom, that we have several choices of sampling algorithms. This is frosting on the cake. I read 

somewhere that I should use Bicubic Sharper when downsizing so that is what I do. Most programs donôt give us 

all these choices. Then we should click on File>Save As and give the photo a new name. I often just use the same 

name and add ñ_800pxò so the next time I will know it is ready to e-mail. Here we can choose the JPEG format and 

the compression amount. Photoshop Elements 6 is out now and sells for about $100. If you are able to spend that 

much and want one of the best editing programs, I highly recommend it. 

 

 

 

 

 

 

Letôs look at Picasa2. It is a free program 

from Google and looks really good but I do 

not have much experience with it. By all 

means, try it first because the price is right! 

When it comes to e-mailing photographs, it is 

a little more automated but not any easier to 

use than Elements. First, click on 

Tools>Options>E-Mail . Then select the 

width you want in pixels. There are six 

choices. Then click on Apply  and OK .  

 

The next step is to click on File>E-Mail  and you will get three choices of how you want to e-mail your photos. For-

tunately, I use Outlook Express so my choice is listed. 

 

When I clicked on Outlook Express, an e-mail page popped up with the photo attached. At this point we can write 

something else on the e-mail and send it. I recommend this so the recipient will know it is really from you and not 

something sent out by a virus. When I receive e-mails that only say ñAttachedò, I Delete them without looking at the 

attachment. This saved me one time when I received a virus from my sister-in-law that she did not know she sent. 

She spent weeks and dollars getting her computer back up. Oh, I digress. If you want to send more than one picture 

(Continued from page 12) 

(Continued on page 14) 


